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Introduction                                           

This document is one of several aids provided to help users install and use Win IATE.
Familiarity with the use of Windows is assumed.  Also assumed is some understanding of airline
communication principles, particularly interchange/terminal addressing and display/printer
options.

As a first step, an overview of the entire Win IATE system is presented, followed by the
instructions for installing and using the Win IATE printer software.  

__________________________________________________________________________
Overview                                                                       

The WinIATE system has several components, including communications software and hardware
that provide connectivity to the Host, printer software to control airline printers, and terminal
emulation software that provides airline terminal functionality.  

WinIATE works in conjunction with the InnoSys Gateway software and hardware installed on a
workstation in a Local Area Network (LAN) or Wide Area Network (WAN) environment.  The
Gateway is normally connected to the Host modem through a standard RS-232 cable.    

A typical Win IATE system is shown below: 

Diagram of typical LAN-based WinIATE system
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__________________________________________________________________________
Upgrade Information                                                                       

If you are upgrading the printer software only (not the entire WinIATE package) from a previous
version of the printer software, the following upgrade procedure is recommended:

• If the IATE_PRT program is running, stop it (e.g., choose Exit from the File menu).

• Back up the IATE_PRT.EXE and the PCFG files from the WinIATE product directory
where the previous version resides.

• Copy the new IATE_PRT.EXE  file into the same directory, so that it replaces the
previous version.

• Since the new version of the program replaced a previous version, it should be possible to
start IATE_PRT.EXE  using the same shortcut icon that was previously used to start the
printer software.

______________________________________________________________________________
Requirements

The 16-bit version of the printer program runs on any PC with Windows 95, 98, or NT,
Windows for Workgroups, or Windows 3.1 or 3.11.  The 32-bit version of the printer program
requires Windows 95, 98, or NT.  The PC must have a TCP/IP interface to a network through
which it can communicate with the IATE Gateway.

For the 16-bit or 32-bit printer program in Windows 95, 98, or NT, the Windows TCP/IP network
connectivity must be set up.  For the 16-bit printer program in Windows for Workgroups, or
Windows 3.1 or 3.11, a TCP/IP (Winsock) stack must be installed and set up.

For Windows 95 or 98, we recommend no less than 8 Mb RAM installed in the PC.
For Windows NT, at least 16 Mb of RAM is recommended.  A PC running Windows for
Workgroups, or Windows 3.1 or 3.11, should have no less than 4 MB of RAM installed.
Additional RAM may improve system performance.

A text editor or word processor that can read and write ASCII files will be required, in order to
modify the printer program’s configuration files.  Suitable editors include Windows Notepad,
DOS Edit, and other editors that can read and write text-only files.
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Preparation

Before installing the Printer Software, it is important to properly set up the PC and install an
InnoSys IATE Gateway on the network.  Also, identify the Object Name that is defined for this
printer within the Gateway configuration.

______________________________________________________________________________
The LAN/WAN

The Printer Software communicates with the Gateway over a Local Area Network (LAN), or
possibly a Wide Area Network (WAN), using TCP/IP.  Ensure that Windows TCP/IP protocol
support is installed and configured, and that the network is up and running, before trying to
install or start the printer software.

If the printer program is to be used with an NT or UNIX gateway, the PC that runs the printer
program must be able to establish TCP/IP connections to that NT or UNIX system.  If the printer
program is to be used with a Mac gateway, the PC must be able to establish a TCP/IP connection
to a Mac that is running the IATEtcp software.

A ping utility can be used to check the required connectivity to the a UNIX or NT system that
runs  Gateway, or to the Mac that runs IATEtcp.    To check connectivity, use ping with that
machine’s IP address or network name.  For example, suppose that the IP address of the Gateway
or IATEtcp machine is 192.0.1.18, and that its name on the network is gatehost.
Enter:

ping 192.0.1.18
or:
ping gatehost

and press the Enter key.  The utility should report receipt of responses from the Gateway
machine.  If no responses appear, stop the ping utility and try it again once more, using the
correct IP address.  If there is still no response, check the IP addresses and any other configuration
parameters on both sides of the connection.

In Windows 95, 98, and NT, the ping command can be entered on the command line in a DOS
Prompt window.  On a Windows 3.x or Windows for Workgroups PC, a ping utility may have
been provided with the TCP/IP stack or by another party; or it may not be available.  If ping is
not available on the PC, and if the Gateway runs on NT or UNIX, then a suitable alternative is to
use ping from the Gateway machine to check connectivity to the Windows PC.

If ping fails to establish connectivity to a Macintosh system, ensure that you specified the
Mac where the InnoSys IATEtcp utility is running.  (See the InnoSys Mac Gateway
documentation for more information on IATEtcp.)
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If you find that ping obtains responses when you specify the IP address, but fails to obtain
responses when you specify the Gateway system by name, then the Windows PC is unable to
locate the Gateway system by name.  There may be a problem with the Windows TCP/IP 
name-resolution configuration on the network.  Depending on how the system’s network
options are set up, the name-resolution options might be found in the DNS or WINS options
in a Network / TCP/IP control panel; or else the name-resolution might use a hosts or lmhosts
file.  In Windows 3.1, 3.11, or Windows for Workgroups, check the TCP/IP stack’s name-
resolution configuration, which probably involves a hosts or lmhosts file.  Connectivity to an
external DNS or WINS server may also need to be verified.  These are Windows and office
network configuration issues, outside the scope of this document.  Problems in this area
may best be investigated by personnel familiar with your Windows PCs and network.

A successful ping test verifies basic connectivity, but does not ensure that the printer program can
contact the Gateway.  If the printer program fails to contact the Gateway, this may indicate that
the installation or configuration of the printer program is not complete.  For example, the printer
program’s OBJECT_NAME configuration item (discussed below) might not correctly specify the
name of the Gateway, or might not specify a TCP/IP service name and an IATE printer object
name that can be found in the Gateway configuration.
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______________________________________________________________________________
The IATE Gateway Name, Service Name, and Printer Object Name

In order to configure the Printer Software for operation, it will be necessary to know the name of
the IATE Gateway host, the TCP/IP service-name by which to contact the Gateway, and an
available IATE Printer Object Name that is specified in the Gateway’s configuration.  Obtain
these names before beginning the printer program configuration process.  These names will be
specified in parameters to the prnter program’s OBJECT_NAME configuration directive, discussed
in the Configuration Directives section of this document.

Note that these names are “case-sensitive”, meaning that upper vs. lower case distinctions
generally are significant.  Whether a name contains all lower case, or a mixture of upper and
lower case letters, make note of the name precisely so that you’ll be able to establish the correct
configuration with the OBJECT_NAME configuration directive.

______________________________________________________________________________
The Gateway Host Name

For connections to an NT or UNIX gateway, the “Gateway host name” is the network name of the
NT or UNIX system where the Gateway is installed.

For connections to a Mac gateway, the “Gateway host name” (from the printer program’s
perspective) is the name of the Mac running the IATEtcp utility, which is not necessarily
the same as the Mac running the Mac IATE Gateway.

If you have already installed and configured WinIATE terminal software on the PC and
successfully established its connection to the Gateway, then the Gateway name (or its numeric
IP address) is shown in the terminal’s Link Configuration item under the File menu.

Before proceeding, you may wish to verify connectivity to the Gateway host, by using the ping
test described earlier.
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______________________________________________________________________________
The TCP/IP Service Name

The TCP/IP “service name” is the name associated with a TCP/IP network “port number” which
the printer program uses in order to connect to the Gateway.   This name is usually ialcserver
in typical installations (usually associated with TCP/IP port #1413).  For some installations the
required service name is different.

If you have already installed and configured WinIATE terminal software on the PC and
verified its connection to the Gateway, you may find the service name in the terminal’s
Link Configuration item under the File menu.

If the required name is not already known from WinIATE configuration or other information,
the procedure described in Appendix D may be used to detemine the correct name for connection
to an NT or UNIX gateway.  The procedure for a Mac gateway with IATEtcp is somewhat
different and is not documented here — refer to Mac gateway and IATEtcp documentation, and
contact InnoSys for assistance if necessary.

______________________________________________________________________________
The Printer Object Name

A printer object name must be created for each printer as part of the Gateway configuration
process.  See the Gateway documentation for information on how to configure object names for
the Gateway.  If a printer may take any available TA from a “group” of printer TAs which has
been defined at the Gateway, then the printer program configuration will specify the name of the
group in place of the object name.

A printer object name is different from a CRT object name.  The printer program is not intended
for use with CRT objects.  The object name you specify in the printer program configuration
should be listed as a printer object in the Gateway configuration.
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Installing the Printer Software

______________________________________________________________________________
Installation for Windows 95, 98, or NT

For Windows 95, 98, or NT systems, use the installer program provided with the WinIATE
package to install the printer software along with the other WinIATE software components.  The
installer places shortcuts to all of the WinIATE software components together in the InnoSys
folder which can be found under the Programs menu after installation.

After installing the software, proceed through the configuration and setup procedures described in
the remainder of this document.  Also, read the Important Notes concerning the 16-bit and 32-bit
versions, on the next page.

______________________________________________________________________________
Installation for Windows 3.1, 3.11, or Windows for Workgroups

Use the installer program provided with the WinIATE package to install the printer software
along with the other WinIATE software components.  The installer places all of the WinIATE
software components together into the InnoSys program group.  An icon for the printer program
should appear there.
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Important Notes concerning the
16-bit and 32-bit versions  (November 1998)

Currently, the WinIATE installer will install the 16-bit version of the printer program, along with
a beta version of the 32-bit printer program.  When you double-click the installed shortcut icon for
the printer program, this will start the 16-bit version.  The 32-bit beta version is, currently, for
experimental use only.

The 16-bit and 32-bit versions differ in some configuration characteristics as well as internal
design.   Although the 16-bit version remains current at this time, the 32-bit printer program will
eventually supplant it for new installations for Windows 95, 98, and NT.

The 16-bit version is a single-threaded program designed for Windows 3.x and Windows for
Workgroups, but it can also operate in Windows 95 and 98, and Windows NT.  The 32-bit version
is a multithreaded program designed specifically for Windows 95, 98, and NT.

Although the major design differences are internal, the 32-bit version also adds a few
configuration options that the 16-bit program does not support.  See, for example, the new
print-control options discussed in the subsection Special Print-Control Directives: to set
orientation, font, etc., in the Configuration Directives section.

The 32-bit version also provides expanded support for ATB/ATB2 printers.  The 32-bit printer
program supports ATB/ATB2 printing on SABRE, SwissAir, Galileo, and KAL host connections.
The 16-bit program currently supports ATB/ATB2 printing for SABRE and KAL, but not
SwissAir or Galileo host connections.  For details on the ATB-related configuration directives
refer to the subsection on Special Directives for use with ATB/ATB2 Printers, in the
Configuration Directives section.

If you wish to experiment with the 32-bit version, remember that it requires
Windows 95, 98, or NT.
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Command-Line Options

To examine or change the printer program’s command-line options, you’ll need to locate the
printer program shortcut or icon, and edit its properties.  Instructions for doing so can be found at
the end of this section..

The printer program’s command-line options are listed below:

-ffilename

Specifies the name of a configuration file.
Example:  -fTI885

Each configuration file defines connection and printing parameters
for one printer-object.  Typically only one configuration file is specified,
but more than one can be specified by placing multiple -ffilename
options on the command line.  Configuration options are explained later
in this document.

-vlevel

Sets the message window debugging level, which controls the
diagnostic messages that appear in the printer program window.
The level is specified in hexadeximal notation.
A typical example:  -v7f

-llevel

Sets the log file debugging level, which copies diagnostic messages into a
file named plog.log.  This option might be used along with the -v option,
usually with the same level.
Example:  -l7f

-Vlevel

(Note the capital -V; this is different from the -v option.)
This sets the API debug logging level.  API debug messages
appear in a file named iatelog.log, not in the printer program window.
A typical example:  -Vffff

-b

Causes the program to hide its window.
Although the window will not be visible, the program can run normally.
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If no parameters are used on the command line, then the program will use the configuration file
named pcfg, and will run in the foreground (with a visible window) without any debugging or
log-file messages enabled.

This sample command line specifies a configuration file name of pcfg.ti, and background
operation (with no window):

iate_prt.exe -fpcfg.ti -b

Following are instructions on how to find and edit the printer program’s command-line options.

______________________________________________________________________________
Editing Command-Line Options in Windows 95, 98, or NT

Find the installed InnoSys folder and open it.  Find the iate_prt shortcut icon inside the folder.
Click the mouse once on the shortcut and choose Properties from the File menu.  A properties
window  should appear.  Click the Shortcut tab near the top of the properties window, and look
for the Target text entry field which shows the file path to iate_prt.exe.  You may add
command-line options at the right-hand end of the text in that field.  Do not remove any of the
existing text in the field— if you do, the shortcut may not be able to start the printer program.

Consider creating a copy of the shortcut item as a ‘backup’ before making any changes.  If you
make any accidental changes which cause the shortcut to fail, you can revert to your backup.

______________________________________________________________________________
Editing Command-Line Options in
Windows 3.1, 3.11, or Windows for Workgroups

Find the iate_prt icon in the InnoSys program group.  Click the mouse once on the icon, and
choose Properties from the File menu.  A properties dialog should appear, including a
Command-Line Options field which you can edit.
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Configuring the Printer Software

______________________________________________________________________________
Configuration Files

Configuration information for the printer program is kept in text files called “configuration files”.
Each configuration file configures a single printer-object connection, including the information
necessary to:

• establish a connection to an IATE Gateway printer TA object,
• properly receive print data from the airline host, and
• configure the connection to the printer.
• configure the format of printed output.

Many installations use only one printer object.  In that case, a single configuration file is
sufficient.  However, the software can also use multiple configuration files in order to specify
multiple printer objects and printers.  The 16-bit version of the printer program can accept only
one or two configuration files.  The 32-bit printer program can accept an essentially unbounded
number of configuration files, limited only by certain system resources.

The -ffilename command-line option specifies the name of a configuration file.
If that option is not specified on the command line, then by default the program uses the
configuration file named pcfg.  If multiple configuration files are to be used, each must be
specified with a separate -ffilename command-line option.

To edit the configuration file, use a text editor such as Windows Notepad or DOS EDIT.  (It’s
also possible, but generally not recommended, to edit the configuration file with a word processor
such as Word; but in that case you must be sure to save the file as plain “text”, not a Word
document.)
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______________________________________________________________________________
Configuration Directives

The configuration file’s contents consist of plain text (sometimes called “ASCII text” or
“DOS text”, not a formatted file like a Word document).  Each non-blank line of text in the file
contains a “configuration directive” or a comment.

A configuration directive consists of a Keyword and, depending on the keyword, may also
require an additional Parameter, on the same line, separated from the Keyword by blank space.
For example, the OBJECT_NAME configuration directive and its parameter would appear on a line
like the following:

Keyword: Parameter:
OBJECT_NAME @host\ialcserver\printer01

A comment is any line that begins with the ‘#’ character.  Comments are entirely optional; they
can be added to explain the configuration or to explain specific directives.  They are solely for
user reference — the printer program ignores any comments and any blank lines in the file.

The printer configuration file format is somewhat similar to the format used in NT and UNIX
Gateway configuration files, but not quite the same.  Printer configuration files are not broken
down into separate titled “sections” like the NT and UNIX Gateway configuration files.
Instead, all of the configuration directives in a file may be listed in any order or sequence.
(Sample configuration files, shown elsewhere in this document, illustrate typical usage and
ordering of configuration directives.)
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______________________________________________________________________________
“Local” and “Remote” Printers

The printer software can print through local or remote printers.  A local printer is connected to
the PC that runs the printer program.  A remote printer is not connected directly to the local PC,
but can be reached through the TCP/IP network (on an office’s Ethernet LAN for example).

______________________________________________________________________________
Local Printers

Local Serial Printers

A local serial printer can be connected to a serial port such as COM1 or COM2.
The printer program can print to a local serial printer in either one of two ways:
by sending output directly through the COM port to the printer, or by submitting output
indirectly through the Windows print management (spooling) facility.

If you wish to print directly to a serial port, the PORT_NAME configuration item specifies the
COM port (usually COM1 or COM2), and related items specify communication details such as the
BAUD_RATE.  The printer program takes exclusive ownership of the serial port in order to print
through it directly; therefore, other Windows or DOS applications should not attempt to use the
same serial port and printer at the same time.

If you wish to print through Windows print management, or spooling, a SPOOL... directive
will be required.  For example, SPOOL_ALL routes all types of prints (host, local, and peer) to the
spooled printer.  See More Information about Spooled Printing below.

Local Parallel Printers

A local parallel printer may be connected to a parallel port such as LPT1.  The printer program
can print to a parallel printer only through spooling.  The printer program does not provide a
direct output directive for parallel ports.  The PORT_NAME directive cannot specify a parallel
port such as LPT1, for example.

See More Information about Spooled Printing below.
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______________________________________________________________________________
Remote Printers

A remote printer is one which the printer program can access through a network connection.
A remote printer is not connected directly to the computer that is running the printer program.
Remote printers generally operate through “redirected” LPT... connections from the local PC.
From the printer program’s point of view, these look much like local parallel ports; and the same
requirements apply:  The printer program will use the spooling facilities to print to the remote
printer, so a SPOOL... directive will be required.  See More Information about Spooled Printing
below.

For instance, a remote parallel printer is a printer connected to a parallel port on a separate PC
which is connected to the office network.  Another common type of remote printer is the stand-
alone “network printer”, such as an office laser printer with its own connection to the network
(typically an Ethernet connection).  Another possibility is that a remote printer might be serially
connected to a UNIX system on the network.  In all of those cases, the printer would need to be
designated on the local PC as the default Windows printer, and a SPOOL... directive would be
required.

However, remote serial printers are less common in Windows environments.  Some third-party
products can enable the printer program’s PC to use remote COM ports on other Windows PCs.
These remote serial ports might appear on the local PC as “redirected” COM ports, and in that
case they might be specified with the PORT_NAME configuration item.  This would be considered
a special-purpose configuration, since it would requirethird-party software.  Contact InnoSys if
further information is needed.

______________________________________________________________________________
More Information about Spooled Printing

“Spooled” printing means: printing through Windows print management facilities that you can
configure in the Printers area of the Windows Control Panel.  By “spooling” we mean that the
printer program submits its output to Windows for printing, and Windows places the output
temporarily into a holding area (sometimes called a “spool”) while attempting to print.

With spooled printing, Windows can arbitrate access to the printer on behalf of multiple applica-
tions; so it  is possible for multiple applications to submit information to be printed on one
printer.  Windows will keep the applications’ print jobs separate and print them one-at-a-time.

In order to be used with spooling, a printer must be set up in the Printers area of the Windows
Control Panel, e.g. through the ‘Add Printer’ procedure.  Refer to Windows documentation or the
online help accessible through the Printers control panel.

Normally, the printer program will send spooled print jobs to the Windows Default printer
designated in the Printers area of the Windows Control Panel.  The SPOOL_PNAME directive can
specify a Windows printer other than the default.
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______________________________________________________________________________
Which Configuration Directives are Required?

Every configuration file should contain certain required directives to specify an
Object connection (which is the connection a Printer TA Object configured at the Gateway),
and to specify Printer connections (to a directly connected serial printer and/or a local or remote
Windows printer).  Some additional directives, though generally “optional”, may be needed
depending on the airline host and the printer being used.

______________________________________________________________________________
Required Object Connection directives

Object Connection directives must be specified in order to establish the connection to the
Gateway and prepare to receive print data from the Host.  First, the OBJECT_NAME and USE
directives must be specified with their required parameters.

The OBJECT_NAME directive must specify the Gateway and Object names, discussed earlier in
the Gateway Host Name, TCP/IP Service Name, and Printer Object Name section.  These names
must be specified in a special syntax.  Refer to the description of OBJECT_NAME in the
Configuration Directives section.

A printer designated for screen use only, with USE SCREEN, can only be used for screen prints
from the IATE terminal emulator. A printer designated for host use only, with USE HOST, can
only be used for host prints.  A printer designated with USE SHARED may be used for both host
and screen prints (the printer program will arbitrate between host and screen prints).

Note:
It is not necessary to use the printer program for screen prints, because the WinIATE terminal software can send
screen prints to a Windows printer.  But it is possible to use the printer program for screen prints if desired.

Depending on Gateway configuration particulars, it may be necessary to set the
NO_TA_TIMEOUT, NO_HEARTBEAT, or AUTO_ANSWER directive.  For details, please refer
to each directive’s description in the Configuration Directives section.
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______________________________________________________________________________
Required Printer Connection  directives

The required Printer Connection directives depend on whether spooled printing or direct serial
printing will be used.   Refer to the “Local” and “Remote” printers section for a discussion of
spooled vs. direct serial printing.

For spooled printing to the Windows default printer (which may be a local or a remote printer),
one of these SPOOL... directives should be specified:  SPOOL_ALL, SPOOL_HOST, or
SPOOL_SCREEN.  SPOOL_ALL routes all printouts for the configured printer object to the spooler,
so that none of the printouts will be sent to a COM serial port (even if a serial port is configured
with PORT_NAME).  The SPOOL_HOST and SPOOL_SCREEN directives route only the specified type
of printout (host or screen) to the spooler, and allow the other type of printout to go to the serial
port (if one is configured with PORT_NAME).

For direct printing through a serial port, the PORT_NAME item should specify the port such as
COM1.  The related items BAUD_RATE, PARITY, STOP_BITS, and CHARACTER_SIZE should
also be set, to define the communication parameters for the serial connection.    It is also
advisable to specify one of RTS_CTS, XON_XOFF, or DISABLE_FLOWCONTROL to select an
appropriate flow-control mode.  USE_DSR or ASSUME_ONLINE may also be needed, depending
on the connection cabling and the desired treatment of offline conditions.  For details please refer
to each directive’s description in the Configuration Directives section.

Additional configuration directives will probably be required, to suit the specifics of the
operating environment.  For example, TICKET specifies ticket printing; various formatting and
handling directives assist in meeting the requirements with particular airlines and printers;
ATB/ATB2 printers have special required directives; and so forth. The individual directives’
descriptions provide some details.
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______________________________________________________________________________
List of Configuration Directives

Following is a list of configuration directives, organized into categories.  Each directive is
marked as either Required or Optional, with further explanations where appropriate.  Although
almost all of the directives are “optional” in a general sense, every configuration file will need
some of the optional directives in order to suit the airline host type and printer being used.

______________________________________________________________________________
Object Connection Directives

These directives define the printer program’s connection to a printer TA object.
The printer object (or group) must be defined in the IATE Gateway configuration. 

Keyword: Parameter: This directive is required .
OBJECT_NAME @host\service\object

This directive specifies the fully-qualified name of the printer object.  A fully-qualified name
includes all information that the printer program will need to find and connect to this printer
object:  the Gateway host name, the TCP/IP service name, and the printer object name.

The host name specifies the host machine where the ALC Gateway is running.  The
object name must match an Object Definition in the Gateway configuration file for that
host.  The required service name is usually ialcserver, but may be different.  Refer
to the discussion in the Gateway Host Name, TCP/IP Service Name, and Printer Object Names
section.

For example, a complete OBJECT_NAME directive might look like this:

OBJECT_NAME @nt_gateway\ialcserver\printer01

Note the use of reverse-slash (\) characters in the parameter.
Forward-slash (/) characters will not work.

Keyword: Parameter: This directive is required .
USE HOST or SCREEN or SHARED

This directive specifies the print job type for this printer: Host prints, terminal Screen prints,
or both.  (SHARED specifies that the printer can be used for both host and screen prints.)
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Keyword: Parameter: This directive is optional.
FINAL_EOMS EOMC, EOMI, EOMU, and/or EOMPB

FINAL_EOMS specifies one or more types of EOM character(s) which, when received at the
end of a message segment from the host, will cause the printer program to consider the
message complete.  The appropriate configuration will depend on the airline host type and
possibly the printing mode (e.g. Ticket vs. Invoice printing, etc.)  The default set of
“final EOMs” is: EOMC and EOMU.

Refer to Gateway documentation for information about EOM characters.
EOM denotes “End Of Message”.  EOMC is “EOM-Complete”, EOMI is “EOM-Incomplete”,
EOMU is “EOM-Unsolicited”, and EOMPB is “EOM-PushButton”.

Keyword: (No Parameter) This directive is optional.
COLLECT_ALL

This directive affects the printer program’s treatment of of messages containing multiple
segments.  If this directive is specified, the printer program collects all segments of a
message before beginning to print the message.

If this directive is not specified, the printer program prints each segment immediately upon
receipt, without waiting for the remainder of the message to arrive from the host.

Keyword: (No Parameter) This directive is optional.
NO_TA_TIMEOUT

If NO_TA_TIMEOUT is specified, the printer program tells the Gateway not to time-out the
object connection because of inactivity.

If NO_TA_TIMEOUT is not specified, the Gateway may or may not time-out and disconnect
the object due to inactivity, depending on the Gateway’s TA Timeout configuration
directive.

Win IATE Printer Reference Manual • © InnoSys Incorporated • November, 1998        page 18



Keyword: (No Parameter) This directive is optional.
NO_HEARTBEAT 

If NO_HEARTBEAT is specified, the printer program will not send heartbeats to the Gateway.
If NO_HEARTBEAT is not specified, the printer program will send heartbeats to the Gateway
at approximately 1-minute intervals.

An NT or UNIX gateway may require these heartbeats, depending on its
HEARTBEATS_REQUIRED directive.

A Mac gateway does not require heartbeats by default;
but if you do not set the NO_HEARTBEAT directive, then the printer program begins to send
the heartbeats and, as soon as the Mac gateway receives the first heartbeat, it expects to
receive them thereafter.

When a gateway detects the loss of 1-minute heartbeat messages from the printer program,
then the Gateway may disconnect the session.

Keyword: (No Parameter) This directive is optional.
ACK_FINAL_AFTER_XFER

This directive instructs the printer program to temporarily withhold its acknowledgment to
the host, for the final segment of a print message, until after the program has begun its
attempt to print that segment.  In the case of a directly-attached serial printer (defined by the
PORT_NAME directive), the program sends the acknowledgment after sending the final
segment through the COM port to the printer.  In the case of a local or remote Windows
printer (defined by a SPOOL... directive), the program sends the acknowledgment after
sending the final segment to the Windows print spooler.

This directive may be of some help in avoiding overrun conditions while sending a series of
long print jobs from the host to a relatively slow printer.
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______________________________________________________________________________
The “Spooling” Directives:  for printing to Windows printers

The SPOOL_ALL, SPOOL_SCREEN, and SPOOL_HOST directives (listed on the next page) specify
which types of printouts (if any) should be sent to a Windows printer through standard Windows
printing facilities.   (“Windows printers” comprise the printers that are defined in the Printers area
of the Windows Control Panel).  

These directives’ names refer to the term “spooling”, because Windows may place print messages
in a holding area, sometimes called a “spool”, while attempting to print them.

A configuration file should specify at least one destination printer.  It may be a Windows printer
as indicated by one of SPOOL_ALL, SPOOL_HOST, or SPOOL_SCREEN.  A configuration file
should specify no more than one of these three directives.

Alternatively, the destination printer may be a directly-attached serial printer specified by
PORT_NAME, or else a disk file specified by FILE_NAME.  For details, refer to the descriptions of
those directives.

Advanced users may choose to specify two printers in one configuration file:  one being a
Windows printer for either Host or Screen prints (either SPOOL_HOST or SPOOL_SCREEN),
and the other a directly-attached serial printer or a disk file to print the other type of print job
(Screen or Host).  For example, you could specify SPOOL_HOST to route host-prints to a
Windows printer, and also specify either PORT_NAME or FILE_NAME to route terminal screen-
prints (i.e., printouts not accounted for by SPOOL_HOST) directly to a serial printer or disk file.

The SPOOL_ALL, SPOOL_HOST, or SPOOL_SCREEN directive overrides PORT_NAME
and FILE_NAME for all prints, host prints, or screen prints, respectively:

• If the SPOOL_ALL directive is specified, then it overrides PORT_NAME and FILE_NAME
unconditionally.  The program routes all printouts, for the printer object specified by
OBJECT_NAME, through Windows print management.

• If SPOOL_HOST is specified, then it overrides PORT_NAME and FILE_NAME for
host prints only:  The program routes host prints through Windows print management,
but sends screen prints to the COM port or file if defined by PORT_NAME or FILE_NAME.

• If SPOOL_SCREEN is specified, then it overrides PORT_NAME and FILE_NAME for
screen prints only:  The program routes screen prints through Windows print management,
but sends host prints to the COM port or file.

The spooling directives are described further on the next page.
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Note:  The  directives on this page are optional.  Use one  of them if you wish to
print to a Windows printer using the standard Windows printing facilities.

Keyword: (No Parameter) This directive is optional.
SPOOL_ALL See Note above.

A configuration file that specifies SPOOL_ALL indicates that all printouts, for the printer
object defined in that file, should be sent to a Windows printer: either the designated default
Windows printer, or the printer specified with the SPOOL_PNAME directive.

Since SPOOL_ALL routes printouts to a Windows printer exclusively, it is not useful to place
a PORT_NAME or FILE_NAME directive in the same configuration file.  With SPOOL_ALL
specified, no printouts would be sent to the serial port defined by PORT_NAME or the file
defined by FILE_NAME.

A configuration file should specify no more than one of
SPOOL_ALL, SPOOL_HOST, or SPOOL_SCREEN.

Keyword: (No Parameter) This directive is optional.
SPOOL_HOST See Note at top of page.

A configuration file that specifies SPOOL_HOST indicates that host print jobs should go to a
Windows printer: either the designated default Windows printer, or the printer specified with
the SPOOL_PNAME directive.  (Screen prints may be routed to a separate serial printer defined
by PORT_NAME, or a disk file defined by FILE_NAME).

A configuration file should specify no more than one of
SPOOL_ALL, SPOOL_HOST, or SPOOL_SCREEN.

Keyword: (No Parameter) This directive is optional.
SPOOL_SCREEN See Note at top of page.
or:
SPOOL_LOCAL

A configuration file that specifies SPOOL_SCREEN (or SPOOL_LOCAL) indicates that terminal
screen print jobs should go to a Windows printer: either the designated default Windows
printer, or the printer specified with the SPOOL_PNAME directive.  (Host prints may be routed
to a separate, directly-attached serial printer defined by PORT_NAME, or a disk file defined by
FILE_NAME.)

A configuration file should specify no more than one of
SPOOL_ALL, SPOOL_HOST, or SPOOL_LOCAL.
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Keyword: Parameter: This directive is optional.
SPOOL_PNAME printer-specification

[This directive refers to Windows 3.x printer profile information.
A future revision of the printer program may provide
 additional functionality for Windows 95/98/NT.]

This directive changes the meaning of the SPOOL_ALL, SPOOL_SCREEN, and/or SPOOL_HOST
directives so that they print to the specified Windows printer instead of to the default
Windows printer.  The “printer specification” must exactly match one of the lines in
the “[devices]” section of the Windows 3.x profile information (“win.ini” file), for
example:

Generic / Text Only=TTY, LPT1:

If the  SPOOL_PNAME directive is specified, then either SPOOL_SCREEN, SPOOL_HOST,
or SPOOL_ALL must be specified.

Keyword: Parameter: This directive is optional.
SPOOL_CMD command-name

This directive defines a print spooling command.  This directive is necessary only if the
standard Windows printing facility is not sufficient for your printing requirements.  The
command name should contain the entire command necessary to print (except for the
filename to be printed).

If SPOOL_CMD is specified, the printer program ignores the SPOOL_PNAME setting if it is
present in the same configuration file.

Win IATE Printer Reference Manual • © InnoSys Incorporated • November, 1998        page 22



______________________________________________________________________________
Serial Connection directives:  for printing directly through a serial port

Keyword: Parameter: This directive is optional.
PORT_NAME port-name Use it if you wish to print

directly to a serial printer.

The PORT_NAME directive defines a serial printer connection, with the name of a COM port
(COM1, COM2, etc.) to which a printer is attached.  The program prints directly to the specified
COM port.

Only one COM port may be specified in each configuration file.  For the 16-bit version of the
program, the port name can specify any available serial port in the range from COM1 through
COM9 inclusive.  For the 32-bit version, the port name can specify any available COM port
defined in the system.  The COM port you choose should not in use by any other applications.

(Most PCs have one or two COM ports built in.  COM1 is sometimes a 9-pin male connector
on the PC, and COM2 is sometimes a 9-pin or 25-pin male connector.)

If a PORT_NAME is specified, it is also necessary to specify BAUD, STOP_BITS,
CHARACTER_SIZE, and PARITY according to printer interface requirements.

The PORT_NAME and FILE_NAME directives should not be used together in the same
configuration file.  Use one or the other, to specify printing to a COM port (PORT_NAME)
or to a disk file (FILE_NAME), but not both.

A Spooling directive, SPOOL_ALL, SPOOL_HOST, or SPOOL_SCREEN, overrides
FILE_NAME and PORT_NAME for all prints, host prints, or local (screen) prints, respectively.
For details, see The Spooling Directives.
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Keyword: Parameter: This directive is optional,
BAUD 110, 300, 1200, 2400, 4800, but recommended if 

7200, 9600, 19200, or 38400  PORT_NAME is specified.

This directive specifies the baud rate (data transfer rate) in bits-per-second (BPS) for a serial
printer connection on the COM port specified by PORT_NAME.  The data rate specified by this
directive must match the rate that the printer itself is configured for (typically by switches on
the printer, for example).

Check your printer’s baud rate setting and configure the BAUD directive accordingly.
The default is 4800 BPS if the directive is not specified.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.

Example:

BAUD 9600

Keyword: Parameter: This directive is optional,
STOP_BITS 1 or 2 but recommended if 

 PORT_NAME is specified.

This directive specifies the number of stop bits per character for a serial printer connection on
the COM port specified by PORT_NAME.  The default is 1 stop bit per character.

The number of stop bits specified by this directive should match the setting that the printer
itself is configured for (typically by switches on the printer, for example).  Some printers may
have a fixed setting that cannot be changed by switches or other means.  The default value
of 1 is often the correct choice.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.

Example:

STOP_BITS 1
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Keyword: Parameter: This directive is optional,
CHARACTER_SIZE 5, 6, 7, or 8 but recommended if 

 PORT_NAME is specified.

This specifies the number of data bits per character,  for a serial printer connection on the
COM port specified by PORT_NAME.

Many printers may be set for either 7 or 8 data bits.  Settings of 5 or 6 are uncommon
and are not required for most installations.  (Note: This directive has no relation to a 6-bit
ALC host-line character code set.)

Check your printer’s setting for the character size, or number of “data bits”, and configure the
CHARACTER_SIZE directive accordingly.  If this directive is not specified, the default is 7
data bits per character.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.

Example:

CHARACTER_SIZE 8

Keyword: Parameter: This directive is optional,
PARITY ODD or EVEN or NONE but recommended if 

 PORT_NAME is specified.

This directive specifies the character parity for a serial printer connection on the COM port
specified by PORT_NAME.

Check your printer’s parity setting and configure the PARITY directive accordingly.
If this directive is not specified, the default is ODD parity.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.
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Keyword: (No Parameter) This directive is optional.
USE_DSR

If this directive is specified, the printer program monitors the DSR (Data Set Ready) signal
on the COM port, to determine whether the printer is online or offline.  If this directive is
not specified, the program instead monitors DCD (Data Carrier Detect; also known as RLSD,
Received Line Signal Detect).   The proper choice depends on the printer’s output status
signal assignment, connector pinout, and cabling to the PC.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.

Keyword: (No Parameter) This directive is optional.
ASSUME_ONLINE

Always assume that the serial printer is on-line.  If this option is not specified, the printer
program checks the DCD signal by default  (or the DSR signal if the USE_DSR directive is
specified) to find out whether the printer is online or offline.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.

Currently, this option has no effect for parallel printer connections, which the printer
program accesses only through the Windows printing facilities (as specified by a SPOOL...
directive).  The Windows printing facilities monitor the printer’s online/offline status
independent of the printer program.
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Keyword: Parameter: This directive is optional.
SECS_DELAY number-of-seconds

This directive specifies a delay time for an online-to-offline printer status change,
on a direct serial printer connection (on a COM port defined by the PORT_NAME directive).

If this directive is not specified, the printer program uses a default delay time of 15 seconds.

To understand the purpose of the delay time, consider how the printer program reacts upon
detecting that a printer has gone offline.  The printer program suspends any further output to
the offline printer.  However, the printer program can retain any data received for printing,
and not immediately discard it, in case the printer comes back online within a short time
period as defined by this parameter.  If the printer does come back online quickly, the printer
program sends the data to the printer; but if it does not come back online, the printer program
discards the data.  The SECS_DELAY directive specifies the time in seconds before the
program discards data.

The delay time also affects data acknowledgments in SABRE protected mode:
If the host attempts to send data to an offline printer during the delay time, the printer
program retains the data (as stated above), without sending any acknowledgment to the
SABRE host during the delay if the printer remains offline.  If the delay expires while the
printer is still offline, then the printer program sends a negative acknowledgment to the host,
indicating Printer-Offline status.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.
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Keyword: Parameter: This directive is optional.
TX_BUSY_TIMEOUT number-of-seconds

This directive defines a delay time for printer-busy status,  on a direct
serial printer connection (on a COM port defined by the PORT_NAME directive).

The default value is 5 seconds if this directive is not specified.

If the printer program detects a printer-busy condition lasting longer than the specified
number of seconds, then the printer program stops sending text to that printer.

The printer-busy condition means that, although the printer is online, it is not ready to print
more data, possibly because it is still busy printing previous data.

The printer program can detect the busy condition by means of the flow-control mechanism
selected by RTS_CTS or XON_XOFF.  For example, with RTS/CTS flow control, the program
considers the printer to be “busy” if:

1.  The printer program activates the RTS (Request-To-Send) signal,
indicating intention to send data to the printer; and

2.  The printer keeps the CTS (Clear-To-Send) signal inactive
to indicate that the printer is busy, not ready to print more data.

This directive applies only to COM port connections, defined with the PORT_NAME directive.
This directive does not apply to spooled printing or print-to-disk configurations.
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______________________________________________________________________________
Flow Control directives  (for serial printer connections)

These directives control the printer program’s optional use of RTS/CTS flow control
(also called “ready/busy” or “hardware” flow control), or XON/XOFF flow control
(also called “start/stop” or “software” flow control).

If you wish to use RTS/CTS or XON/XOFF flow control, specify either RTS_CTS or XON_XOFF,
but not both.  If neither is specified, the default is to use RTS/CTS flow control, unless
DISABLE_FLOWCONTROL is specified.

These directives applies only to COM port connections, defined with the PORT_NAME directive.
These directives do not apply to spooled printing or print-to-disk configurations.

Keyword: (No Parameter) This directive is optional.
RTS_CTS 

If this directive is specified, the printer program uses RTS/CTS flow control (also called
“ready/busy” or “hardware” flow control) for the serial printer connection on the
COM port specified by PORT_NAME.

If you wish to use RTS/CTS or XON/XOFF flow control, specify one of RTS_CTS or
XON_XOFF, but not both.  If neither is specified, the default is to use RTS/CTS flow control,
unless DISABLE_FLOWCONTROL is specified.

Keyword: (No Parameter) This directive is optional.
XON_XOFF

If this directive is specified, the printer program uses XON/XOFF flow control (also called
“start/stop” or “software” flow control) for the serial printer connection on the COM port
specified by PORT_NAME.

 

Keyword: (No Parameter) This directive is optional.
DISABLE_FLOWCONTROL

Turns off flow control monitoring, so that neither RTS/CTS nor XON/XOFF flow control
will be used.  This directive is provided in order to override the default RTS/CTS flow
control.  To ensure predictable results, do not specify RTS_CTS or XON_XOFF along with
DISABLE_FLOWCONTROL.
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______________________________________________________________________________
Print-to-Disk directives

Keyword: Parameter: This directive is required for
FILE_NAME file-name Print-to-Disk configurations only.

This directive activates print-to-disk functionality, specifying a file for output.
If SEPARATE_MESSAGES (see below) is not specified, the program “prints” (writes)
messages into a single file in sequence.  If SEPARATE_MESSAGES is specified, file-name
specifies the base file name, to which a unique extension will be added for each separate
message file.

The FILE_NAME and PORT_NAME directives should not be used together in the same
configuration file.  Use one or the other, to specify printing to disk or to a COM port,
but not both.

A Spooling directive — SPOOL_ALL, SPOOL_HOST, or SPOOL_SCREEN — overrides
FILE_NAME and PORT_NAME for all prints, host prints, or screen prints, respectively.
For details, see The Spooling Directives.

Keyword: (No Parameter) This directive is optional.
SEPARATE_MESSAGES

For print-to-disk  (with the FILE_NAME directive), this directive causes each message to be
placed in a separate file.  When using this directive, specify a FILE_NAME without an
extension.  Each message will have a unique numeric extension.

For example, if FILE_NAME specifies the name “message”, and SEPARATE_MESSAGES is also
specified, then message files will be named message.1,  message.2, and so forth.
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______________________________________________________________________________
Carriage Return / Line Feed (CR/LF) directives

These directives control the printer program’s output of Carriage Return (ASCII code 13
decimal, 0D hexadecimal) and Line Feed (ASCII code 10 decimal, 0A hexadecimal) at the end
of each printed line.  One of these directives may be needed in order to correct printing problems
such as these:

• The printer does not advance the paper from one line to the next
 (possible solution: CR_TO_CRLF or CR_TO_LF)

• The printer double-spaces lines which should be single-spaced
(possible solution: CRLF_TO_CR)

At most one of the following directives should be specified.
If more than one of them is specified, the resulting output is undefined.

Keyword: (No Parameter) This directive is optional.
CR_TO_CRLF

“Add Line Feed after Carriage Return”:
If this directive is specified, the printer program adds a Line Feed character after each
Carriage Return character received in print messages, before sending the text to the printer.

Keyword: (No Parameter) This directive is optional.
CRLF_TO_CR

“Remove Line Feed after Carriage Return”:
If this directive is specified, the printer program removes the Line Feed character in each
Carriage Return / Line Feed sequence received in print messages, before sending the text to
the printer.

Keyword: (No Parameter) This directive is optional.
CR_TO_LF

“Convert Carriage Return to Line Feed”:
If this directive is specified, the printer program substitutes a Line Feed character in place of
each Carriage Return character received in print messages, before sending the text to the
printer.
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Keyword: (No Parameter) This directive is optional.
LF_TO_CR

“Convert Line Feed to Carriage Return”:
If this directive is specified, the printer program substitutes a Carriage Return character in
place of each Line Feed character received in print messages, before sending the text to the
printer.

Keyword: (No Parameter) This directive is optional.
LF_TO_CRLF

“Add Carriage Return before Line Feed”:
If this directive is specified, the printer program adds a Carriage Return character prior to
each Line Feed character received in print messages, before sending the text to the printer.
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______________________________________________________________________________
General Output-Formatting Directives

Keyword: (No Parameter) This directive is optional.
SPACE_BEFORE_CR

If this directive is specified, the printer program adds a blank Space character prior to each
Carriage Return in print messages, before sending the text to the printer.  Certain printers
may require this setting, but most do not.

Keyword: Parameter: This directive is optional.
LEFT_MARGIN number-of-spaces

This directive provides a way to adjust the left margin by simply printing a number of
blank spaces at the beginning of each line.  For example,   LEFT_MARGIN  3
specifies that each line of printed output will begin with 3 blank character spaces.

Keyword: (No Parameter) This directive is optional.
DONT_SUPPLY_FF

This directive disables the automatic insertion of Form Feeds.  If this directive is not
specified, the printer program inserts Form Feed (FF) characters as needed in order to begin
each printed message at the top of a page.

Keyword: Parameter: This directive is optional.
REPLACE_FFS number-of-linefeeds

If this directive is specified, the printer program substitutes the specified number of Line
Feed characters in place of each Form Feed character received in a message, before sending
the text to the printer.
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______________________________________________________________________________
Testing/Diagnostic Directive

Keyword: Parameter: This directive is optional.
TEST_PRINT file-name

Enables the “Printer Test” selection in the File Menu.  If a file name is specified, that file
will be printed when “Printer Test” is selected from the menu.  Otherwise, a standard
test pattern will be printed when “Printer Test” is selected.

______________________________________________________________________________
Window Control Directive

Keyword: Parameter: This directive is optional.
RUN_MINIMIZED password-in-hexadecimal

This directive causes the printer program to “minimize” (iconify) its window upon starting
up.  This directive requires one parameter, a password.  The password should be entered as a
series of one or more hexadecimal character codes, representing the ASCII characters of the
password.  For example, if the password is “EBMES”, this parameter would be entered as:
“RUN_MINIMIZED 45 42 4D 45 53”. 

When the operator clicks on the minimized icon representing the printer program, the
program issues an input prompt for the password.  The operator must enter the password in
order to open the printer program window.

(If you want the printer program to run without any visible window or icon, use the “-b”
option on the command line, as described in the Command-Line Options section.)

Win IATE Printer Reference Manual • © InnoSys Incorporated • November, 1998        page 34



______________________________________________________________________________
TAB Expansion Directives  for Apollo  host connections

Keyword: (No Parameter) This directive is optional.
NO_TAB_EXPANSION

This is a Horizontal Tab handling directive for Apollo host connections.

This directive instructs the printer program to convert the ALC Horizontal-TAB character
(value 2C hexadecimal) to ASCII Horizontal-TAB (9) before sending it to the printer.

If this directive is not specified, the printer program converts the ALC TAB character to a
series of ASCII Space characters sufficient to reach the next tab stop.

Keyword: Parameter: This directive is optional.
TABS AIRLINE or AGENCY

This is a Vertical Tab handling directive for Apollo host connections.

If the AIRLINE setting is specified, the printer program converts the ALC Vertical-TAB
character (value 3C hexadecimal) to ASCII Form-Feed (0C hexadecimal / 12 decimal),
and selects tab-stops appropriate for Airline printing.  If AGENCY is specified, the program
converts 3C to Carriage Return, and selects tab-stops appropriate for Agency printing.

The default setting is AGENCY if this directive is not specified.

Note:  The X3C_TO_ETX directive, if specified, will override the TABS directive.

Keyword: (No Parameter) This directive is optional.
X3C_TO_ETX

This is a Vertical Tab handling directive for Apollo host connections.

If this directive is specified, the printer program converts the ALC Vertical-TAB character
(value 3C hexadecimal) to an ASCII End-of-Text character (ETX, character code 3)
before sending it to the printer.

If this directive is not specified, the program will convert character 3C to Form Feed or
Carriage Return as required, depending on the TABS directive.
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______________________________________________________________________________
Special Directives   for Air New Zealand  host connections

Keyword: (No Parameter) This directive is optional.
IGNORE_NZFLUSH

This directive enables special message handling for Air New Zealand host connections.
This directive should not be used with other host types.
 
This directive instructs the printer program to ignore the printer “flush” message from an
Air New Zealand host system.

Keyword: (No Parameter) This directive is optional.
INTERCEPT_ROTTY

This directive enables special message handling for Air New Zealand host connections.
This directive should not be used with other host types.
 
If this directive is specified, the printer program performs special processing for
Air New Zealand ROTTY messages.

Keyword: (No Parameter) This directive is optional.
MESSAGE

This directive enables special message handling for Air New Zealand host connections.
This directive should not be used with other host types.
 
If this directive is specified, the printer program assumes that the printer is used to print
messages only (not tickets). 

Keyword: (No Parameter) This directive is optional.
TICKET

This directive enables special message handling for Air New Zealand host connections.
This directive should not be used with other host types.
 
If this directive is specified, the printer program assumes that the printer is used to print tickets
only (not regular messages). 
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______________________________________________________________________________
Special Directives  for other host types

Keyword: (No Parameter) This directive is optional.
STX_ETX

This directive causes the printer program to send the “Start of Text” character
(STX, character code 02) before the first character of each printed message, and the
“End of Text” character (ETX, code 03) after the end of each message.

This directive may be required for certain printers, and may be needed on EgyptAir
connections.

For ATB and ATB2 printers, use SUPPLY_STX and/or SUPPLY_ETX instead, if required.

Keyword: (No Parameter) This directive is optional.
BLOCK_NUMBERING

Some hosts, such as EgyptAir, may add a block number to certain types of printer messages
(usually ticket images) to help insure message integrity. 

If you have specified the HASH_TOTAL or BLOCK_NUMBERING directive, and there appear
to be some characters missing at the beginning of each printed message block, then you
may need to remove one or both of these directives..

Keyword: (No Parameter) This directive is optional.
HASH_TOTAL

Some hosts, such as EgyptAir, may use a hash total value comprising 2 characters at the
beginning of certain types of printer messages (usually ticket images).  This is an error-
correcting checksum to help insure message integrity.

If you have specified the HASH_TOTAL or BLOCK_NUMBERING directive, and there appear
to be some characters missing at the beginning of each printed message block, then you
may need to remove one or both of these directives.
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Keyword: (No Parameter) This directive is optional.
BLANK_COMPRESSION

Some hosts, such as EgyptAir, may use a special blank compression scheme in certain types
of printer messages to reduce the amount of data that is sent to the printer.  This is typically
used for ticket printers.

If the columns in a printout are not aligned correctly, and some unexpected characters
(within the range from “C” through “Z”) appear in a place where more blank space
would be expected, then you may need to specify BLANK_COMPRESSION.

If BLANK_COMPRESSION is specified, and printouts show a number of extra blanks,
or some characters appear to be missing, then you may need to remove this directive.

Keyword: (No Parameter) This directive is optional.
ISEA-TICKET

This directive enables special message handling for El-Al host connections. 
This directive should not be used with other host types.

This directive causes the printer to reformat messages according the El-Al specifications.

Keyword: (No Parameter) This directive is optional.
CPARS_FORCE

This directive is only used with the CPARS host type.
This directive instructs the printer program to interpret received data as CPARS data
— even if the CPARS host type is not selected in the IATE Gateway configuration.

Keyword: Parameter: This directive is optional.
DEVICE_TYPE DEV_TTY or 

DEV_CENTRONICS or
DEV_TERMINET

This directive is only used with the CPARS host type.
This directive instructs the printer program to perform character translations
appropriately for the specified CPARS printer type.
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______________________________________________________________________________
Message Notation directives

These directives specify special notations or marks to be printed along with each
message sent to the printer(s) defined in the configuration file.

Keyword: (No Parameter) This directive is optional.
TIMESTAMP

This directive causes the printer program to output a header line, containing an
8-digit message-number and the current date and time, above each message printed.

The header line’s format is shown in the following example.  This example shows
message number 152 printed on Monday, January 1st, 1999 at 12:30 PM.
The time appears in a 24-hour format, as hour:minute:second, from
00:00:00 to 23:59:59.

message:00000152 at Mon Jan 01 12:30:00 1999

Keyword: Parameter: This directive is optional.
MESSAGE_MARK value

This directive specifies a 2-digit hexadecimal value (value) which defines the ASCII code
for a character be placed at the end of each message.  For example, to terminate each
message with the exclamation-mark character ‘!’, value would be set to 21:
the hexadecimal representation of the ASCII code for the character ‘!’.
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______________________________________________________________________________
Special Print-Control Directives:  to set orientation, font, etc.

With some printers, the directives described in this section can control printout characteristics
such as the orientation (Portrait or Landscape), the font in which characters are printed, and
possibly other parameters. 

The SETUP_STRING directive provides access to the physical printer’s control commands.
With this directive, you specify command codes that the printer program sends to the printer.
Some (not all) printers provide a rich set of commands to control various printout characteristics,
which may include the orientation and font (as well as other parameters such as margins and
print-quality options).  Such commands, if available, are documented in the printer’s user manual
and cannot be described here.

The other three directives described in this section can be used instead of SETUP_STRING, but
only to control the orientation and font.  The ORIENTATION directive selects either Portrait or
Landscape orientation; and the FONT_NAME and FONT_SIZE directives select a font and its size.
These directives operate through the Windows print-control facilities and printer-driver software,
to control the printer indirectly.  This is somewhat similar to selecting a font and orientation in a
word processor or text editor.
 
If you do not use any of these printer program directives to select an orientation or font, then
your printouts may appear in a default or previously selected font.  This may be acceptable in
some situations; especially if you are using a printer that does not provide multiple fonts or
control of orientation, or if you are satisfied with the results you get from the printer’s default
settings.  However, if you are using an advanced printer, such as an inkjet or laser, you may
have reason to experiment with the options available through these directives.

In some networked printing environments, these directives may be useful to ensure a consistent
orientation and font, when airline printouts are interspersed with printouts from other
applications that use different settings.
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Before you decide to use the SETUP_STRING directive or the
FONT_NAME, FONT_SIZE, or ORIENTATION directive,
be sure to consider the following limitations:

• These directives can be used with the 32-bit printer program only.
The 16-bit printer program does not support these directives. 

• Generally, if you use the SETUP_STRING directive in a configuration file,
then you cannot use any of the other three directives discussed in this section:
ORIENTATION, FONT_NAME, or FONT_SIZE.

• If you are using a serial printer on a COM port selected by PORT_NAME,
then you can use the SETUP_STRING directive,  but you cannot use
ORIENTATION, FONT_NAME, or FONT_SIZE  with that printer.

• If you use a SPOOL... directive to send printouts to a Windows printer, and you
use the SETUP_STRING directive to send commands to that printer, then you’ll
also need to specify SPOOL_BINARY.

• If you are using the ORIENTATION, FONT_NAME, and/or FONT_SIZE directives,
then do not use SPOOL_BINARY.

• ORIENTATION, FONT_NAME, and FONT_SIZE do not work with the
“Generic / Text Only” printer driver.

For details on these directives, refer to the descriptions on the following pages.
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Keyword: Parameter: This directive is optional.
SETUP_STRING sequence of hex character codes

This directive can be used with the 32-bit printer program only.
The 16-bit printer program does not support this directive. 

This directive allows the user to define a setup string, which the printer program will send to
the printer at the beginning of every message.  This can be used to re-initialize the printer, set
printer-specific options, etc.  This typically involves printer-specific command sequences that
often begin with the ASCII “Escape” control character (code 1B hexadecimal).

The parameter values for this directive are a series of 2-digit hexadecimal numbers, separated
by spaces.  These values represent character codes.  There may be at most 30 characters in the
string.

For example, the string 1B 71 is an escape sequence that causes certain printers to print in
condensed mode.   If this sequence happened to be appropriate for the type of printer you are
using, you could specify it this way:

SETUP_STRING    1B 71

Check your printer’s user manual before specifying and using any setup string.
The user manual may describe the commands that the printer can accept in setup-strings.
Such commands are sometimes called Escape Codes or Escape Sequences, because they
often involve sending the Escape character followed by some command characters. 

Important Notes:

• If you use a SPOOL... directive to send printouts to a Windows printer, and you wish
to use SETUP_STRING to send commands to that printer through the spooler, then
you’ll probably need to specify SPOOL_BINARY as well.  Setup-strings may specify
arbitrary character codes, and  SPOOL_BINARY permits the full range of 8-bit character
codes to pass through the spooler to the printer.

• Many printers support a rich set of commands which may be specified through
setup-strings.  It is up to the user to determine the suitability of this directive in a
particular configuration, and to decide whether it is worthwhile to review the printer
documentation to determine the necessary command codes. 

(continued on next page)
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• One possible reason to use a setup-string would be to specify the orientation of a print-
out (portrait or landscape, i.e. printing each line across the paper left-to-right, vs.
lengthwise from top to bottom).  Another possible purpose would be to specify a font
and a font-size.

If you are using a SPOOL... directive to print to a Windows printer,
with a Windows printer-driver other than “Generic / Text Only”,
then you may be able to use the ORIENTATION, FONT_NAME, and FONT_SIZE
directives (instead of using SETUP_STRING) to control the orientation and font.

Keyword: Parameter: This directive is optional.
ORIENTATION PORTRAIT or  LANDSCAPE

This directive can be used with the 32-bit printer program only.
The 16-bit printer program does not support this directive. 

This directive specifies the printout orientation: either Portrait (printing each line across the
paper left-to-right), or Landscape (printing lengthwise from top-to-bottom).

This directive applies only to printouts routed to a Windows printer by using a
SPOOL... directive.  This directive does not work if SPOOL_BINARY is specified. 
This directive does not work with the “Generic / Text Only” Windows printer driver.
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Keyword: Parameter: This directive is optional.
FONT_NAME font-name

This directive can be used with the 32-bit printer program only.
The 16-bit printer program does not support this directive. 

This directive specifies a Windows font for printing.

If this directive is not specified, the printer program does not attempt to select a particular
font for printing.  In that case, or if the directive specifies a font that Windows or the printer
driver cannot provide, then the printout may use a default or previously-selected font instead.

This directive applies only to printouts routed to a Windows printer by using a
SPOOL... directive.  This directive does not work if SPOOL_BINARY is specified. 
This directive does not work with the “Generic / Text Only” Windows printer driver.

The font-name parameter should specify the name of a font that Windows and the currently
selected printer driver can support.  Note that the font name may contain spaces.

Currently, the printer program cannot display a list of available fonts.  To see a list of
fonts that are available with the current Windows default printer, you can run WordPad (in
the Windows Programs / Accessories menu) and view the available font names that appear in
the list-box beneath the toolbar near the upper left corner of the WordPad window.
(Click the list-box to open it and view the complete list.)

To illustrate the use of FONT_NAME, here are three separate examples.

FONT_NAME Courier
FONT_NAME Courier New
FONT_NAME Lucida Console

You can only use one FONT_NAME directive in each configuration file.

Fixed-width fonts are generally more suitable for airline printing than variable-width fonts.
Typically, only a very few fixed-width fonts may be available.

Some printers and drivers support TrueType scalable fonts, which can be identified by a ‘TT’
symbol beside a font’s name in the WordPad font list.  (Among the examples above,
you may have noticed both “Courier” and “Courier New”.  “Courier New” is a TrueType
version of Courier.)  Some printers and drivers support a mix of several TrueType fonts
and a few non-TrueType fonts.

The most basic printers and drivers, such as the “Generic / Text Only” driver commonly used
with dot-matrix utility printers, do not support multiple font selections through the Windows
printing facilities; so the FONT_NAME directive cannot work with them.  In such situations, it
may be possible to control the printed character set by using SETUP_STRING instead.
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Keyword: Parameter: This directive is optional.
FONT_SIZE size (in Points)

This directive can be used with the 32-bit printer program only.
The 16-bit printer program does not support this directive. 

This directive specifies the font-size, in points.  This directive applies only to printouts routed
to a Windows printer by using a SPOOL... directive.  The default is 12 points if this directive
is not specified.

This directive applies only to printouts routed to a Windows printer by using a
SPOOL... directive.  This directive does not work if SPOOL_BINARY is specified. 
This directive does not work with the “Generic / Text Only” Windows printer driver.

The most basic printers and drivers, such as the “Generic / Text Only” driver commonly used
with dot-matrix utility printers, do not support font size control through the Windows printing
facilities; so the FONT_SIZE directive cannot work with them.  In such situations, it may be
possible to control the printed character size by using SETUP_STRING instead.
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______________________________________________________________________________
Special Directives for use with ATB & ATB2 Printers

The directives described in this section are intended for use with ATB/ATB2 ticket printers.
Generally, these directives should not be used with other types of printers. 

The printer program supports ATB/ATB2 printing only on directly-connected serial printers
(as defined by PORT_NAME and related directives; see the example below).  The printer program
does not  support ATB/ATB2 printing on parallel printer connections, nor any other printers
operated through Windows print management (as defined by a SPOOL... directive).

The 32-bit printer program supports ATB/ATB2 printing on SABRE, SwissAir, Galileo, and
KAL host connections.  The 16-bit program currently supports ATB/ATB2 printing for SABRE
and KAL, but not SwissAir or Galileo host connections.

Note that the PRINTER_TYPE directive is required for all ATB/ATB2 printer connections; but
the other directives in this section are applicable only if the PRINTER_TYPE parameter is set to
GENERIC_ATB2.  (See the discussion of PRINTER_TYPE etc. on the following pages.)

Following is a sample configuration file showing typical settings for a SABRE ATB2 printer.

Sample Configuration for a SABRE ATB2 printer:

OBJECT_NAME @gateway\ialcserver\printer01
AUTO_ANSWER OFF

PRINTER_TYPE SABRE_ATB2

PORT_NAME COM1
BAUD 4800
PARITY NONE
CHARACTER_SIZE 8
STOP_BITS 1

ASSUME_ONLINE
DISABLE_FLOWCONTROL

The BAUD_RATE, PARITY, STOP_BITS, and CHARACTER_SIZE may differ for other SABRE ATB2
printer configurations.  For example, some may use 2400 baud, and some may be set for Even parity
and 7 data bits.  Check your host configuration.

For SwissAir or Galileo ATB/ATB2 printers, use PRINTER_TYPE SWISSAIR_ATB2 or 
PRINTER_TYPE GALILEO_ATB2.  Again, the serial communication parameters must be
set appopriately; for example, a typical printer may default to 9600 baud, 8 data bits,
no parity.  Check the printer setup or documentation.

For other types of ATB/ATB2 printer connections such as KAL, use
PRINTER_TYPE GENERIC_ATB2 and other necessary directives listed below.
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Keyword: Parameter: This directive is required for
PRINTER_TYPE SABRE_ATB2    or ATB2 printer connections only.
 SWISSAIR_ATB2 or
 GALILEO_ATB2  or
 GENERIC_ATB2

This directive specifies that the printer defined in the current configuration file is an
ATB/ATB2 printer, and specifically, that it is compatible with either SABRE ATB2 protocol,
SwissAir/Galileo ATB2 link protocol, or other ATB/ATB2 protocols such as KAL.

• The SABRE_ATB2 setting should be used for SABRE ATB/ATB2 printers.

• The SWISSAIR_ATB2 and GALILEO_ATB2 settings are synonymous; one or the other
should be used for SwissAir or Galileo ATB/ATB2 printers.

• The GENERIC_ATB2 parameter covers other host types.
The program currently supports KAL protocol in this category.

The rest of the directives discussed in the remainder of this section are intended for use
with the GENERIC_ATB2 printer type.

When GENERIC_ATB2 is specified, certain ATB/ATB2 printing options take default values,
unless set to other values by other directives as described in the remainder of this section. 
Some of these directives may be required in order to suit a particular printer, its current
configuration, and the airline host’s configuration on the printer TA.  Also notice that some of
these directives affect messages sent from the printer to the host, as well as messages sent
from the host to the printer.
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Keyword: Parameter: This directive is optional.
ATB_SUGGESTION SHARES or

KOREAN_MODE0 or
KOREAN_MODE1

This directive is applicable only if the PRINTER_TYPE directive specifies GENERIC_ATB2.
This directive is not for use with other ATB/ATB2 printer types or non-ATB printers.

This directive changes several ATB-related parameters at once, to suit a specific
 airline host type.

Note:  This directive cannot be used to specify host types other than those listed here.
In particular, do not specify the SABRE host type with this directive.
For SABRE printers, you can instead use: PRINTER_TYPE SABRE_ATB2

Following are the specific parameters that the ATB_SUGGESTION directive sets
for SHARES, KOREAN_MODE0, and KOREAN_MODE1. 

ATB_SUGGESTION  SHARES
sets three parameters for Shares host connections,
equivalent to the following directives:

REPLACE_C1C2_WITH_STX
HEADER_LENGTH    16
REATTACH_HEADER  1

ATB_SUGGESTION  KOREAN_MODE0
sets several ATB printing parameters for KAL connections,
equivalent to the following directives:

HEADER_LENGTH     4
REATTACH_HEADER   0
REPLACE_C1C2_WITH_STX
STX   0a
ETX   0c

ATB_SUGGESTION  KOREAN_MODE1
sets one ATB printing parameter for KAL host connections,
equivalent to the following directive:

REPLACE_C1C2_WITH_STX
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Keyword: (No Parameter) This directive is optional.
DISABLE_ACKS

This directive instructs the IATE Gateway not to adcknowledge message segments
on behalf of the printer program.  (This directive applies specifically to the printer
TA object referenced in the configuration file where this directive is used.)

Keyword: Parameter: This directive is optional.
HEADER_LENGTH length

This directive specifies the length (in characters) of a message header that the printer
program should remove from the beginning of each print message received from the airline
host via the Gateway, before sending the message to the ATB/ATB2 printer.

Depending on the REATTACH_HEADER directive (see below), the printer program may save a
copy of the header characters received from the host; and also add those characters at the
beginning of any response message received from the ATB/ATB2 printer, before sending the
response message to the host via the Gateway.

If this directive is not specified, the printer program will not remove and add header
characters in the manner described above.  (However, notice that some other directives
described in this section can affect certain message headers and trailers in other ways.)

Keyword: Parameter: This directive is optional.
REATTACH_HEADER 0 or 1

If the HEADER_LENGTH directive (see above) has not been specified,
then the REATTACH_HEADER directive does not apply, and has no effect.

If the HEADER_LENGTH directive has been specified, and REATTACH_HEADER is specified
with parameter value 0, then the printer program will not add header characters to messages
sent from the ATB2 printer to the airline host.

If the HEADER_LENGTH directive has been specified, and REATTACH_HEADER is specified
with parameter value 1, then the printer program will add header characters to messages
sent from the ATB2 printer to the airline host.

If the HEADER_LENGTH directive has been specified, but REATTACH_HEADER is not specified,
then the printer program will add header characters to messages sent from the ATB2 printer
to the airline host.
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Keyword: Parameter: This directive is optional.
STX value-in-hexadecimal

This directive specifies a Start-of-Text (STX) character code for ATB/ATB2 printing.

If this directive is not specified, the default value is 02, which is the
ASCII standard STX character code.

Keyword: Parameter: This directive is optional.
ETX value-in-hexadecimal

This directive specifies an End-of-Text (ETX) character code for ATB/ATB2 printing.

If this directive is not specified, the default value is 03, which is the
ASCII standard ETX character code.

Keyword: Parameter: This directive is optional.
SUPPLY_STX number-of-characters

This directive specifies the number of STX characters that the printer program should add
at the beginning of each message received from the airline host via the Gateway, before
sending the message to the ATB/ATB2 printer.

Also, the printer program will remove the same number of STX characters from
response messages sent from the ATB2 printer to the host.

(Note that the STX character code is normally 02, but can be redefined by the
STX directive described above.)

Keyword: (No Parameter) This directive is optional.
SUPPLY_ETX

This directive instructs the printer program to add a single ETX character at the beginning
of each message received from the airline host via the Gateway, before sending the message
to the ATB2 printer.

Also, the printer program will remove an ETX character from response messages sent from
the ATB2 printer to the host.

(Note that the ETX character code is normally 02, but can be redefined by the
ETX directive described above.)

Keyword: (No Parameter) This directive is optional.
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REPLACE_C1C2_WITH_STX  

If this directive is specified, the printer program will replace the C1 and C2 characters
(a pair of airline-specific header characters) with the STX character, in each message received
from the airline host via the Gateway, before sending the message to the ATB2 printer.

(Note that the STX character code is normally 02, but can be redefined by the
STX directive described above.)

Keyword: (No Parameter) This directive is optional.
SUPPLY_ATB_END

This directive is intended for use with certain Apollo host connections.

If this directive is specified, the printer program adds a message-ending character to the end
of each message received from the airline host via the Gateway, before sending the message
to the ATB2 printer.  The addition is made after the ATB2 checksum (LRC and/or DRC)
characters.  The printer program also removes the ending character in messages sent from
the printer to the airline host.

Keyword: Parameter: This directive is optional.
ATB_END value-in-hexadecimal

This directive is intended for use with certain Apollo host connections.
This directive applies only if SUPPLY_ATB_END has also been specified.

This directive specifies the value of an ATB message-end character, in hexadecimal.
If this directive is not specified, the default ATB “end” character value is 06.
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Keyword: Parameter: This directive is optional.
BLOCK_CONTROL NONE, LRC, DRC, or DRC_LRC

This directive controls the printer program’s treatment of ATB/ATB2 Block Check characters.

This directive specifies which Block Check characters the printer program should process:
none, the LRC only, the DRC only, or both DRC and LRC.

In the latter three cases, the printer program calculates and adds the specified Block Check
characters to each message received from the airline host via the Gateway, before sending the
message to the ATB/ATB2 printer.  The printer program removes the specified Block Check
characters in messages sent from the printer to the airline host.

If this directive is not specified, the default  is NONE: the printer program will not process
block-check characters.

Notes on LRC and DRC calculation:

• The LRC calculation method is as follows:
The LRC value is initially zero.  Each data character received in a message updates
the LRC by a logical XOR with the character value.  This method leads to the final
LRC value, after processing all of the data characters in the message.

• The DRC calculation method is as follows:
The DRC value is initially zero.  Each data character received in a message updates
the DRC with a one-bit right-rotation, followed by a logical XOR with the character
value.  This method leads to the final DRC value, after processing all of the data
characters in the message.  Note that the DRC calculation may include the LRC
value, depending on the INCLUDE_LRC directive.
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Keyword: Parameter: This directive is optional.
BLOCK_CONTROL_RANGE INCLUDE_STX,

INCLUDE_ETX,
INCLUDE_STX_ETX,
INCLUDE_LRC, and/or
DATA_ONLY

This directive applies only if the BLOCK_CONTROL directive has been specified with a
parameter value other than NONE.

This directive specifies what portion of the message to  include in the ATB/ATB2
LRC and/or DRC checksum calculations.  The checksum calculations always include the
data characters in the message, but may or may not include the STX and ETX characters.
Also, the DRC checksum calculation (if applicable) may or may not include the LRC
checksum byte.

The calculation may include the STX character, the ETX character, or both; according to
INCLUDE_STX, INCLUDE_ETX, or INCLUDE_STX_ETX.

The INCLUDE_LRC parameter applies only if the BLOCK_CONTROL directive specifies
LRC_DRC checksum calculation.  INCLUDE_LRC specifies that the DRC calculation will
include the LRC checksum value.   If INCLUDE_LRC is not specified, the DRC calculation
will not include the LRC value.

If the BLOCK_CONTROL_RANGE directive is not specified, the default setting is DATA_ONLY:
to include only the data characters in the checksum calculations; not the STX, ETX, or LRC.

Keyword: (No Parameter) This directive is optional.
STRIP_DLE_FROM_BC

This directive instructs the printer program not to include DLE characters
(ASCII code 10 hexadecimal, 17 decimal) in the LRC/DRC checksum calculations.
This is relevant only if DLE characters might appear in the data stream.
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Menus

This section describes the command menus available in the IATE_PRT window.

Currently, these menus serve a limited set of diagnostic functions.  They do not provide
access to configuration items, which must be set in configuration files as described in the
Configuration Directives section.

_____________________________________________________________________________
The File Menu

The File pull-down menu contains the commands shown in the picture below.

 File    Edit    Options Help 
InnoSys Printer Application

Exit

Printer Test

These commands can be invoked from the pull-down menu by using the mouse to click-and-drag
down the menu, pointing to one of the commands, and then letting go of the mouse. Alternatively,
the keyboard can be used to select the menu and item: for example, to select Exit, press Alt+F x.

Printer Test This selection sends a test message to the printer.  This selection is only
available if the “TEST_PRINT” parameter was included in the printer
configuration file.  If a filename was included with the “TEST_PRINT”
parameter, that file will be printed.  Otherwise, a standard test pattern will be
printed.

Exit This selection quits the application.
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______________________________________________________________________________
The Edit Menu

The Edit pull-down menu contains the following command:

InnoSys Printer Application
 File    Edit    Options Help 

Clear Buffer

Clear Buffer Erases any diagnostic messages that may be visible in the application window.
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______________________________________________________________________________
The Options Menu

The Options pull-down menu contains the following commands:

InnoSys Printer Application
 File    Options Help  Edit   

Settings

Printer diagnostics to file
Printer diagnostics to window

Settings Allows the user to configure which diagnostic information is sent
to a file or to the screen.  The configurable diagnostics are
selected from the dialog box shown below.:

Settings

Cancel

OKPrinter Program Diagnostics

Session

Host data

Peer data

Device info

Configuration

Show as printed

Queuing

Errors only

Show state changes

Very verbose

Continued on next page
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Options Menu, continued

Printer diagnostics to file Routes the diagnostics selected by the user in the “Settings”
command above to a file. 

Printer diagnostics to window Routes the diagnostics selected by the user in the “Settings”
command above to the application window on the screen.

If either diagnostic option is selected, this will be indicated by a check mark (“√”) to the left of the
option in the menu.
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__________________________________________________________________________
The Help Menu

The Help pull-down menu provides version information about the printer software.
(Currently this menu does not provide any additional help information.)

InnoSys Printer Application
 File    Edit    Options Help 

About...

The About command displays the version number of the Printer Software.
(This example shows an older version number.  The current version number will be higher.)

About Iate_prt

Version 1.4

OK

Copyright ©1995-1998,  InnoSys, Inc.

X

All RIghts Reserved

Iate_prt Application 
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Appendix A — Printer Cabling
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Workstation-to-Printer Cable Wiring Diagram (DB25)

Workstation  End Printer  End
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To either 11 or 
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on the printer

DB9 Female

DB25 Male
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Workstation-to-Printer Cable Wiring Diagram (DB9)

Workstation  End

Printer  End

11

To either 11 or 

20, depending 

on the printer

9

6

These cables work with both RTS/CTS (“ready/busy”) 
and XON/XOFF (“start/stop”) flow control.
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Appendix B — Sample Printer Configuration files

A typical configuration file for printing to a serial printer such as the TI 810:

#
# Sample configuration for a TI 810,
# 4800 baud, Even parity, 7 data bits, 1 stop bit
#

OBJECT_NAME @westgw\ialcserver\printer12

PORT_NAME com1
BAUD  4800
PARITY EVEN
CHARACTER_SIZE 7
STOP_BITS 1

RTS_CTS

CR_TO_CRLF
REPLACE_FFS 1

A typical configuration file for printing to the default Windows printer:

#
# Sample configuration for printing to the
# default Windows printer
#

OBJECT_NAME @ntgw\ialcserver\print0c

SPOOL_ALL
USE SHARED
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A typical configuration file for printing to a specified Windows printer
(possibly not the default printer):

#
# Sample configuration for printing to a
# specified Windows printer
#

OBJECT_NAME @ntgw\ialcserver\print0c

SPOOL_ALL
SPOOL_PNAME Generic / Text Only=TTY,LPT1:

Note:  The example above uses the SPOOL_PNAME command, which refers to Windows 3.x
printer profile information.  A future revision of the printer program may provide additional
functionality for Windows 95/98/NT.

A typical configuration file for printing to a disk file:

#
# Sample configuration for printing to a disk file
#

OBJECT_NAME @innogw\ialcserver\itin02

FILE_NAME itin02.txt
COLLECT_ALL
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A typical configuration file for printing to a SABRE ATB2 printer:

#
# Sample configuration for a SABRE ATB2 printer
#

OBJECT_NAME @aagw\ialcserver\tkt02
AUTO_ANSWER OFF

PRINTER_TYPE SABRE_ATB2

PORT_NAME COM1
BAUD 4800
PARITY NONE
CHARACTER_SIZE 8
STOP_BITS 1

DISABLE_FLOWCONTROL
ASSUME_ONLINE

The BAUD_RATE, PARITY, STOP_BITS, and CHARACTER_SIZE may differ for other SABRE
ATB2 printer configurations.  For example, some may use 2400 baud, and some may be set for
Even parity and 7 data bits.  Check your host configuration.
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Appendix C — Printer Program Troubleshooting

Following are some of the possible reasons for difficulty in obtaining the expected printed output
from the printer program.

__________________________________________________________________________
Printer Software Does Not Run  

A possible reason why the printer program will not run:

The OBJECT_NAME directive and its required parameter may be entered incorrectly.
This would prevent the printer program from contacting the IATE Gateway
and communicating with the airline host.

• Check the Gateway Host Name, Service Name, and Printer TA Object Name
components of the OBJECT_NAME directive’s required parameter.
Review the  IATE Gateway Host Name, Service Name,  and Printer Object Name
subsection earlier in this manual.

• Verify that the specified object name matches one configured as a printer object in the
IATE Gateway configuration.

• There should be no, space, tab, carriage-return or other control-characters within the
Gateway Host Name, Service Name, or Printer TA Object Name.

Appendix G of the Terminal manual provides a comprehensive problem solving procedure for
resolving gateway connectivity problems.
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__________________________________________________________________________
Printer Software Will Run, But Printer Does Not Print

Possible reasons why a printer being controlled by the IATE printer program will not print:

1) Improper configuration, either in the printer program configuration file, the Printers area
of the Windows Control Panel, or the printer itself (e.g. switch settings).

Review the descriptions of the options you’re using, in the Configuration Directives
section.  Also look for any required directives that may be missing from your
configuration.

For a directly-connected serial printer, check the required PORT_NAME, BAUD_RATE,
PARITY, CHARACTER_SIZE, and STOP_BITS settings.  Check also the flow-control
mode: RTS_CTS (“hardware” or “ready/busy” flow-control) or XON_XOFF (“software”
or “start/stop” flow-control); and make sure the selected flow-control mode matches the
printer’s configuration.  Also check cabling as described in item (2) below.
Check any switch settings, etc., on the printer if you suspect that the printer itself
may be set up incorrectly.  Refer to the printer’s user manual.

For a Windows printer operated through Windows print management, check the required
SPOOL... directive.  Also check the various Windows setup options for the designated
printer, in the Printers area of the Windows Control Panel.  Try printing to this printer
using other Windows applications, to find out whether or not the problem is specific to
the printer program.  Check any switch settings, etc., on the printer if you suspect that the
printer itself may be set up incorrectly.  Refer to the printer’s user manual.

Try the Printer Test function in the File menu.  If it does not print at all, the printer
program may not be able to contact the printer.  Check the PORT_NAME directive for a
directly-connected serial printer, or the printer designation and port assignments in the
Windows Printers Control Panel.  If the Printer Test function does print, but prints
illegibly or improperly, this may indicate problems with the other directives for a serial
printer, or other options in the Printers Control panel, or the setup of the printer itself
(e.g. switch settings).
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2) Improper cable, or cable not connected, or printer set offline.

Check the cable connections, the printer’s on/offline status (possibly a switch on the
printer).  Try turning the printer off and on.

For a directly-connected serial printer, you can check for evidence of a cabling problem
as follows.  Enable printer program diagnostics with a -v... command-line option:
for example: “iate_prt -fpcfg -v7f”.  (See the Command-Line Options section.)
Start the printer program and check for diagnostics in the printer program display
window.  Look for a message like this: “Device Status changed to 3:pONLINE”. 
If you see the status displayed as “pOFFLINE”, then this may indicate a cabling problem.
Check the cable connections, and the cable pinout.  If you have serial port test equipment,
verify that the printer issues an Online signal which passes through the cable on the DCD
signal line (or DSR if you are using the USE_DSR configuration directive).  If you are
using RTS_CTS (a.k.a. “hardware” or “ready/busy”) flow-control, verify that the cable
passes the required RTS signal from the PC to the printer, and the CTS signal from the
printer to the PC.  (Cable checks may require assistance from network personnel and
suitable test equipment.)

For a Windows printer accessed through a SPOOL... directive, check the printer status
in the Printers area of the Windows Control Panel.  Double-click the printer’s icon there
to open a window that shows the status of print jobs for that printer.  Attempt to print
through the printer program, or from other applications, and check to see if the printouts
appear listed (even if only momentarily) in that printer status window while Windows
attempts to print them.  Again check the cabling and the printer’s online status,
particularly if any Windows printer-status warning messages appear on the screen.
Verify that the printer is designated as the “default” Windows printer.

3) The printer may be in use, or may have been left inaccessible, by some other application.

Make sure that the Windows printer, or the COM port in the case of a serial printer, is not
being used by any other Windows or DOS application.  If you suspect that the port may
be in use by some other application that you were using earlier, make sure that you’ve
stopped that application.  If an earlier application that was using the printer may have
crashed or terminated incorrectly and left the printer in an unusable state, try restarting
the PC and/or turning the printer off and on.
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4) The Airline Host or the IATE Gateway is not sending data to the printer program.

You can check for evidence of this problem as follows.
Enable printer program diagnostics with a -v... command-line option:
for example:  “iate_prt -fpcfg -v7f”.  (See the Command-Line Options section.)
Attempt to print, and watch for diagnostic messages in the printer program’s window,
showing printing activity.  If none appear (the window does not show activity during the
print attempt), this may indicate a problem in sending print data from the host to the
printer program.

Check the printer program’s OBJECT_NAME configuration directive, as suggested in the
preceding subsection, Printer Software Does Not Run.

Restart the printer program with diagnostics enabled as described above, and look for
diagnostic messages showing status “sNOT_OPENED” or “sOPENED” for the printer
object.  If the last such status displayed is “sNOT_OPENED” then the printer program may
be having trouble connecting to the Gateway or using the printer object.

Check the status of the printer TA at the host.  Reset the printer status at the Host if it is in
a failed state.  Verify that the printer is properly designated.  Procedures to perform these
tasks vary by airline host type and terminal command set.  If necessary, obtain assistance
from personnel familiar with the required airline terminal commands to designate,
configure, and diagnose the status of the printer TA.

5) The Printer software has been configured using a TA which is not an available Printer
TA.  It may be a CRT TA, or a TA that is not available from the host.

Confirm that the Printer’s Object name corresponds to a TA which is defined at the
Gateway as a type “Printer”, not CRT.  Confirm with the Airline Help Desk that the TA
you have been assigned is defined at the Host as a printer and is available to you.

Win IATE Printer Reference Manual • © InnoSys Incorporated • November, 1998        page 66



__________________________________________________________________________
Printer Software Will Run, But Only Partial Data Prints

Some possible reasons why incomplete or partial printouts may appear on a printer controlled
by the printer program:

1) Improper cabling or configuration.  

Check the cabling, and the relevant configuration parameters for your printer, as
described earlier — see items (1) and (2) in the preceding subsection.  In particular, check
flow-control and online-detection settings, and verify that the cable connects the
necessary signal pins to establish online/offline detection (DCD or DSR) and ready/busy
(RTS/CTS) flow control if they are required.

2) Wrong End Of Message character being used. 
Clue:  The host sends the first segment of a multi-segment message, but no subsequent
segment(s).  The first block may or may not print; and subsequent segments do not print.

Verify that the “End Of Message” characters specified in the FINAL_EOMS directive
(or the defaults if you are not using that directive) are correct for the airline host
to which you are connecting.

__________________________________________________________________________
Printer Prints Unexpected Characters or Spaces

Possible reasons why unexpected characters may appear in printouts:

1) For a directly connected serial printer, the BAUD_RATE, PARITY,
STOP_BITS, or CHARACTER_SIZE parameters may not be set correctly.
Check these parameters as suggested in the earlier subsection
“Printer Software Will Run, But Printer Does Not Print”.
Also refer to that subsection for additional items to check for
a Windows printer accessed through a SPOOL... directive.

2) The HASH_TOTAL, BLOCK_NUMBERING, or BLANK_COMPRESSION
parameters may not be set correctly.  If these directives apply to your
host type (such as EgyptAir), verify the correct parameter values
as required by the host and the printer.
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__________________________________________________________________________
Print-to-Disk Function Does Not Work Properly

Possible reasons why the Print-to-Disk function can fail:

1) The FILE_NAME directive may be incorrectly specified or not specified.
Verify that it specifies a valid file name.

2) Also check the printer program’s OBJECT_NAME configuration directive as suggested in
the earlier subsection, “Printer Software Does Not Run”.

3) There may be a problem in delivering messages from the host to the printer.
Check items (4) and (5) in the earlier subsection,
“Printer Software Will Run, But Printer Does Not Print”.

Note:
The error message “Close of Temporary File fd:-2 failed with errno:9”
may appear in the printer program window if diagnostics are enabled.  That message
does not indicate a significant error, and should be ignored.
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Appendix D — Determining the TCP/IP Service Name

The TCP/IP “service name” is the name associated with a TCP/IP network “port number” which
the printer program uses in order to connect to the Gateway.   This name is usually ialcserver
in typical installations (usually associated with TCP/IP port #1413).  For some installations the
required service name is different.

If you have already installed and configured WinIATE terminal software on the PC and
verified its connection to the Gateway, you may find the service name in the terminal’s
Link Configuration item under the File menu.

If the required name is not already known from WinIATE configuration or other information,
the following procedure may be used to detemine the correct name for connection to an NT or
UNIX gateway.  The procedure for a Mac gateway with IATEtcp is somewhat differentand is not
documented here — refer to Mac gateway and IATEtcp documentation, and contact InnoSys for
assistance if necessary.

This procedure is relatively complex.  Users unfamiliar with TCP/IP services files and their
contents may wish to consult network personnel or InnoSys tech support if assistance is required
in making a successful connection to the Gateway.
If you already have a working service name from WinIATE configuration or other
information, then you probably do not need to follow this procedure.

______________________________________________________________________________
Detailed Procedure to Determine the TCP/IP Service Name
for an NT or UNIX Gateway connection

1. Find the service name specified in the IATE Gateway’s configuration.

• You’ll need to locate the configuration file being used with the Gateway.  That is the
file specified in the -ffilename option on the Gateway (iate_server) command line.

• The file may contain a line similar to the following:

SERVER_NAME    ialcserver

If the SERVER_NAME line is present, take note of the name it specifies, whether it is
ialcserver or some other name.

• If there is no such line in the Gateway configuration file, do not add one.  The service
name ialcserver takes effect by default.

Take note of the service name that you have just determined.
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2. Locate the services file or database on the NT or UNIX Gateway system.

• If the Gateway is on a Windows NT PC, the services file is located in a
subdirectory beneath the main Windows NT directory.  The file can be
found easily through the %SystemRoot% variable, as follows:
%SystemRoot%\system32\drivers\etc\services

Note: Some Windows systems may contain multiple services files.
It’s important to locate the correct file, as described above. 

•    If the Gateway is on a UNIX system, there should be a file named /etc/services
file on that system.

You’ll need to find out whether or not the UNIX system uses an NIS database
(or any other remote network services database) to find TCP/IP service names
and port numbers.  If so, you’ll need to access the database instead of the
/etc/services file.  This document does not describe the procedure to check the
network services database.

3. Locate the ialcserver or similar entry in the services file (or services database),
matching the name you determined in Step 1 above.

• The services file may contain line(s) similar to the following:

ialcserver 1413/tcp

Look specifically for a line containing the service name you found in Step 1.
Take note of the port number on that line (such as 1413).
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4. Locate the TCP/IP services file on thePC where the printer program is installed.

• If the printer program is installed on a Windows NT PC:
The services file is located in a subdirectory beneath the main
Windows NT directory.  The file can be found at this location:
%SystemRoot%\system32\drivers\etc\services

(Note:  The “%SystemRoot%” part of the file-path shown above
is a special notation which automatically refers to the main Windows NT
directory — which may be c:\winnt40 for NT Workstation 4.0,
or some other directory for other versions of NT.)

• If the printer program is installed on a Windows 95 system:
The services file may be located in c:\windows\services

• On a Windows 3.1, 3.11, or Windows for Workgroups system:
The services file should be located in a directory associated with the TCP/IP stack.
If you are using the Microsoft TCP/IP stack with Windows for Workgroups, the
services file may be located at c:\windows\services.  If you are using a third-
party TCP/IP stack, you’ll need to locate its services file:  For example, a Trumpet
Winsock stack might use c:\trumpet\services; or a Sun PC/NFS stack might use
c:\nfs\services or c:\pcnfspro\etc\services.  Other vendors’ stacks will use
other locations.

Note: Some Windows systems may contain multiple services files; it’s important
to locate the correct file which is in active use.

5. Edit the services file on thePC where the printer program is installed.

•    Check for a line in the PC’s services file specifying the same port number
(such as 1413) that you found in Step 3 above.  It may have the same or 
different service name (such as ialcserver).  Take note of the service name.

•    If the services file does not contain a line specifying the same port number that you
found in Step 3, then it is necessary to add such a line to the file.  Again it should
have the same format as other lines in the file, for example:

ialcserver    1413/tcp
(or other name) (or other port number>

Be sure to use the port number you found in Step 3.
You can specify the same service name you used in the Gateway machine’s
services file (recommended), or you can use ialcserver instead.
Take note of the service name you chose.

 

The service name you determined in Step 4 is the one you’ll need to use in the printer program’s
OBJECT_NAME configuration parameters, as discussed in the Configuration Directives section.
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